GUIDE B — EDITING YOUR OWN CONTENT

PART ONE — WINDOWS MOVIE MAKER You may have access to

other software. Use
whichever software you

1. Open up Windows Live Movie Maker. You
are most comfortable

can find this under Start = All Programs =

. . . with.
Windows Live Movie Maker.
Your interface should look like this:
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2. Select ‘Add videos and photos’
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Add videos
and photos

Navigate to the folder where your videos are saved and
select the ones you want to use. Adding Photos.
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While this is the
easiest option, it is
the least reliable.

3. Windows media only accepts some file types. There are
two ways you can try changing the file to an accepted type
Firstly, you can try changing the file extension by
renameing the file. Just add .mov’, “.“mp4’ or *.wmv’ to the

E VID 20130917 101037 end of the file and the file

=[VID_20131021 163552.mpd |  [YP€ might change

Secondly, you can look for file converting technology
through google. Through these programs you can
convert your unplayable video to a more common and
playable video type. Some good options are:
http://www.nchsoftware.com/software/converters.html

(free trial) http://www.zamzar.com/ (free website)

4. Once you have added all the files that you wish to use, they
will appear in your timeline. Now you can begin the editing
process. You can always add more clips to the timeline
throughout the process.
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5. Arrange the files in the rough order that you want them.
Watch through the film to see what works and what
doesn’t. You can always move clips around further down the
process.

6. Now you can begin resizing the clips. There are multiple
ways of doing this. Begin by going to the edit tab.




Home Animations Visual Effects Project View Edit

\ *)’ i, Fadein: None v £ speed:  1x || --l= Jml 3 Set start point
Video g Fade out: None v Split Trim .1 Set end point
volume tool

The first way is using the ‘Split’ tool.
- Select the clip you want to cut.

- Play through the clip. When it gets to the point where
you want to cut it, pause. Then click the split tool.

- You should now have two separate clips. \ the duration of a

If you want to make

- You can either use both parts of the clips or delete the photo shorter,

part that you don’t want to use. these methods will
- You can split one clip at several different points. not work. Instead
The second way is by using the ‘Trim tool’. There are two you must ‘retime’
ways of doing this. The first way is similar to using the split

the photo. Do this
by changing the

tool.
- Watch through the clip until you get to the point where

you want it to start in your final movie. duration” under the

- edit tab.
Jsm|= 5« Set start point

Trim .1 Set end point

tool 4 Duration: 7.00

- Select ‘set start point’. This will remove any footage

from your clip that comes before this point.

- Continue through the clip until you get to the part that
you want to end the clip on and select ‘set end point’.
This will remove any footage on the clip that occurs
after this point.

The other way to trim your clip is by selecting the ‘Trim tool’

button.

Jwl= | S Set start point

Trim | I Set end point
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This will open up a new tab.
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Within this tab, you can adjust the beginning and end

points for your clip by either

- Playing through the clip and clicking the ‘Set start
point’ and ‘Set end point’ buttons,

- Typing in the time code for the start and end
points into ‘Start point’ and ‘End point’ boxes, or

- Dragging along the handlebars on the timeline to
your desired positions.

You can use a combination of all the different

methods to manipulate your clips.

At the end of this process your timeline should look

something like this:

7. Once you are happy with the structure of your film

you can begin to edit the sound. For finding music
You can edit the sound on each individual clip under
the ‘Edit’ tab.

and sound effects
refer to Guide A
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If the sound in some clips is quieter or louder than the
others, you can adjust the volume, using the ‘Video
volume’ button, on the individual clip so that the
sound levels match up across the film.

You can add fades to clips by selecting the clip you
want to apply the fade to and selecting an option
under either the fade in or fade out pull-down menus.
You can choose from a slow, medium or fast fade.
Next you can add music and/or sound effects to the
project. It is easiest to do this by adding only one
track at a time.

N

J
Add
music~

4 Add music..

& Add music at the current point...

When you add music by using the ‘Add music’ button, the
music will automatically start at the beginning on the film
and will cover the duration of the film, or until the song
ends. However once the track is in the timeline you can
move the track around to the desired position in your
film.

By adding music via the ‘Add music at current point’
option, the music track will slot into the timeline where
the playback bar is currently located.

Once music is added to your film, a new tab will appear.
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As before, you can apply fades to the music soundtrack
and adjust the volume the same way you did for the
individual clips. You can also adjust the length of the
song, and the sections you wish to use the same way that
you adjusted the video clips before, using the ‘split’, ‘set
start point’ and ‘set end point’ buttons.

8. Finally when you are happy with the way your film is
looking and sounding you can add in titles transitions
and effects.

a. You can add titles, captions and credits under the
home tab.
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Just click on whichever one you want to add to the
film and a textbox will appear.
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Type in your text and click outside of the window to
save it. If you want to change the text at all you can
double click on the text in your timeline and the
textbox will reopen. You can move the title around to
different positions in the timeline.

When a title is selected a new tab will become
available. Within this ‘format’ tab, you can adjust
many of the different aspects of the title.
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Here you can change the font and the size. You can
also change the duration of the text, the background
colour and add effects to the text. If you want your
title to appear over one of your clips, rather than a
plain background you can use the caption button
rather than the title button.
b. You can add transitions under the animations tab.
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Here you can select different transitions including
crossfades and a variety of wipes. By holding your
mouse over a transition, you can preview it in the
preview window. You can change the length of the

In this animations tab
there are also a variety of
‘pan and zoom’ effects.

transition using the ‘duration’ dropdown. If you want While these can be
one transition across all of your clips you can select applied to your videos,
the ‘apply to all’ button. they are more often used

c. Under the visual effects tab are a number of on photos to make them

mare interesting.




different video effects
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These effects range from basic such as black and
white or sepia, to posterize, pixelate and edge
detection. It is important to remember that when
selecting an effect (or transition) it should match the
mood and themes of your film.

Within this tab you can also alter the brightness of
your clips. This is useful if there are shots across
different locations where the lighting varies

significantly.
Finally, under the Edit tab, you can change the speed
of a clip.
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9. Saving your file.
To export your project as a movie, under the home
tab go to save movie and select ‘for computer’.

Save
movie ¥

Recommended setting
gﬂ% Recommended for this project

Common settings

Ei For high-definition display
‘L\ For computer

€: Burn a DVD

j For email

Select the folder you want to save the file to and click
‘save’. It will take a couple of moments to export the
movie, depending on how big it is. Once it has saved,
a window will pop up asking if you want to open the
movie. Click open and review the film. If you notice
any issues or changes you want to make, you can fix
this on your timeline using previous steps. Then you
can re-save your movie.

It is important for you to review your film once it is
exported as mistakes are often not noticed until the
last minute.



PART TWO - iMOVIE

10. Open up iMovie.
You can find this by going to ‘finder’ >
‘applications’ = ‘iMovie’.
Your interface should look like this.
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11. Create an event. Go to File > New Event
This ‘Event’ is where you will store all of
your media and projects for this film.

12. Add your videos to the event. You can do
this by going File = Import 2 Movies...
Navigate to the folder where your files are
saved and select the ones you want to use.
Select ‘Add to existing Event’ and choose
the one you have just created. Make sure
‘Optimize video’ is selected.

Finally it is a good idea if you have enough
space on your computer to Copy the files
rather than Move them. This ensures that
you have a backup of the videos in case
anything goes wrong.



13. Your screen should now look like this:
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To watch through a
clip, select the clip
and press spacebar.

Remember if you are
having trouble with any of
the steps, there are lots
of tutorials online. Here is
a good one covering the
basics of iMovie:
http://www.youtube.com
/watch?v=aEJjvhnAlwQ

Now you can create your ‘project’. You can
do this by dragging the whole clip, or parts

of a clip that you want to use into the

project box.

To select the whole clip double click on it. (—
Once the clip is highlighted you can drag it

into your project.

If you only want to put part of the clip into
your project single click on the clip. A small
selection clip will appear.

You can then watch through the clip until
you find the desired start and end

By double clicking on the clip an
inspector window opens up.

Inspector

E‘ Video
Source Duration: 7.7s

Stabilization:

Analyze Entire Clip

Here, under the video tab, you
can change the exposure,
brightness, contrast and
saturation. You can also change
the white balance and play
around with basic audio mixing.

positions. You can drag the edges to these
desired positions.

Once the clips are in your timeline, you can
continue to cut them down further. Right
click (or control click) on a clip to see a
number of options including ‘split’ and
‘“trim’



Here is another good
tutorial that focuses on
sound editing:
http://www.youtube.co
m/watch?v=jZ06TKZg360

14.

15.

Once you are happy with the order and
length of your clips you can begin to edit
sound.
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Click the sound button on the right hand side
of iMovie to open up a range of songs and
sound effects free to iMovie.
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Music and Sound Effects

P i iLife Sound Effects
@ iTunes

Name

B Alarm.mp3

Ambient Effect 1.mp3
B Ambient Effect 2.mp3
Ambient Hit.mp3

B Auto Close Door 1.mp3
B Auto Close Door 2.mp3
Auto Open Door 1.mp3
Auto Open Door 2.mp3
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You can also access songs that are in your
iTunes. You can preview the sounds by
selecting one and clicking the play button. If
you want to add it to your project drag it to
the desired part.

You can change the volume levels and add
fades on each of the clips by clicking the
‘info’ button.
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Clip Video

Volume: + .

Ducking: Reduce volume of other tracks to:
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Fade In: @ Automatic

Manual:

Fade Out: @ Automatic

Manual: =@

Normalize Clip Volume

Revert to Original

You can create an audio bridge by
right clicking on a clip and
selecting ‘detach audio’ and then
trimming the clip so that the
audio covers more than just the
clip.
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16. You can add titles from the title tab.
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There are many different types to choose
from with different themes and purposes
such as opening titles, subtitles and credits.
Remember to choose a style that reflects
your film well. You can drag your title
between to clips to select a background to
appear underneath it.

Choose Background

-

Alternatively you can drag a title onto a
specific clip and it will appear over the clip.
You can shorten or lengthen your title by
clicking on the edges and dragging.



17. Finally there are a number of transitions under
the transitions tab.
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You can drag and drop the transition of your
choice between two clips.
18. Your final project should look something like
this.
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19. The final step is to export your film. To do this
go to Share = Export Movie
Here you can choose which size you would like
to export your movie at. It is important to
choose the size that is compatible with how
you share it at a later date.
iMovie will show you which options work for
which platforms. Select export.

Export As: [Zero Budget Film Making‘ ] \z‘

Where: | (2] Movies 4|
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| Cancel |

Once the film has finished exporting it is
important to watch it through. If you notice



any issues or changes you want to make, you
can fix this on your timeline using previous
steps. Then you can re-save your movie. It is
necessary for you to review your film once it is
exported as mistakes are often not noticed
until the last minute.
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